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Chapter 1

About This Release

This set of release notes contains important information not included in other Kofax Transformation

Modules documentation. Please read these release notes carefully before you install, upgrade, or use this
product.

Information about supported operating systems and other requirements is available on the Kofax Support
website at www.kofax.com.

New Features
The following new features are available in Kofax Transformation Modules 6.1.1.

Clear or Save Scripts for Troubleshooting

Two new options are available in the Tools menu of the Script Code window to help with script
troubleshooting.

For more information, see Updated: Script Code Window.

Extraction Debugging - Field Property Change History

A new property and window are now available so that you can record any field changes to a field and view
them at a later time. The results can be viewed in the Extraction Results window or in the XDoc Browser.
These results are helpful when testing or troubleshooting extraction.

Changes in Behavior
The following changes have been made to the behavior of Kofax Transformation Modules 6.1.1

Automatic Dictionary Import

When the Automatic Update option is enabled for a dictionary, the behavior for when a dictionary is

updated has changed. Similarly, this has changed for the Thin Client Server and a new web.config setting
is available to configure the dictionary update behavior.
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Bar Code Recognition

An additional property called MinRatioToTextHeightBarcode iS now available via script. This new
property is used to improve bar code recognition when there are issues with line height.

Document Review Menu Additions

There are several new options in the Document Review Page and the Edit menus. These new menu
options allow more choices for page and document rotation as well as a new option to copy a page to a
new document.

Improved Documentation

Several changes have been made to the documentation based on Enhancement Requests. These
changes will appear in the documentation for the next full release of Kofax Transformation Modules. In the
meantime, these changes are available in the Additional Documentation chapter as follows.

» Document minimum permissions for an SQL database for both Kofax Search and Matching Server and
Kofax Transformation Modules.

» Document that Kofax Search and Matching Server should be installed on a server without any other
Kofax products in production.

* Document SecurityBoost and its use in Kofax Transformation Modules.
* Improve documentation about supported image sizes, formats, and types.

* Improve Database Locator reference and conceptual documentation so that the exclusion databases
behavior is clear.

Improved Application Logging

The configuration for application logging within Kofax Transformation Modules has changed. Instead of
editing Registry settings to determine if a log is created, log file configuration is now done using the Kofax
- Service Configuration tool.

You can configure the following log files.
» Correction

» Document Review

* Knowledge Base Learning Server

» Scheduler (Server Scheduler)

» Server

» Validation

* Verification

There is a single configuration setting called Log file path for the above log files. This means that they
are all saved in the same location.
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Note The configuration for the Thin Client Server log files has not changed. This configuration is still
done in the configuration files. More information onThin Client Server logs is found in the Thin Client
Server Installation Guide.

Improved Batch-Level Logging
Improvements have been made to batch-level logging.

The following batch-level logs are generated automatically.
» Correction

* Document Review

» Validation

» Verification

The amount of details in each log relates to the log level configured for the corresponding application log.

Installation Changes
An MSP is no longer included with Kofax Transformation Modules.
For Kofax Transformation Modules 6.1.1, it is possible to extract the MSP from the executable as follows.

KofaxTransformationModules-6.1.1.exe /T:<full path> /C

Where /T specifies the temporary working folder and /c extracts the files. These two parameters must be
used together if you want to extract the MSP file from the executable.

In addition to these parameters, you can also use /¢ for quiet mode, and /c:<cmd> to override the install
command defined by the author.

The same goes for the Thin Client Server. You can extract the MSP from the executable using these same
parameters.

Reclassify Documents via Script

It is now possible to execute Reclassify in script for the same documents multiple times in the Thin
Clients.

Registry Settings

All configurable registry settings are now available in the Kofax - Service Configuration. It is no longer
necessary to edit the Registry for Kofax Transformation Modules.

Thin Client Validation Keyboard Shortcuts

Thin Client Validation now has several new keyboard shortcuts for editing both the Batch Content and the
Thumbnails panes.
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Resolved Issues

The following are the resolved issues in Kofax Transformation Modules 6.1.1.

Issues Resolved in Tools and Rich Client User Modules

979665 - Reclassify via AfterProcess Event Causes Error

When a document is reclassified when the afterpProcess event is called, the fields on the document are
re-initialized so that any existing extraction field data that is not part of the new class, or does not have the
preserved flat set, is deleted.

Previously, this occurred only when reclassify was called in earlier events. This is now consistent.

964768 - Ignore for Separation Checkbox Failing

It is now possible to clear the "Ignore for Separation" checkbox in Project Builder Separation Project
Settings. Doing so resets the separation settings to their previous state.

961831 - Unwanted Configuration Set

A newly created project no longer contains an empty Configuration Set with the same name as one from a
previously open project.

956302 - Moving Document Sets Causes Processing Problems

Moving a Document Set to a new location in Project Builder no longer causes problems during
classification or extraction.

958839 - Unextracted Kofax Capture Fields Causing Zoom Problems in
Validation

Due to a change in how the Kofax Capture fields are synchronized, Kofax Capture Validation now knows
when a field has no extraction value. The zoom behavior in Validation now works as expected.

955784 - Microsoft SQL Database Issues

It is now possible to configure a Microsoft SQL Server Connection in Project Builder by choosing a new
database if the previously configured database is no longer available.
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920317 - Cannot Sort Batch Field Column

It is now possible to sort the new Batch Field column when displaying the document and page count. This
is related to bug 836537.

908038 - Confirmation Error on Last Document with Drop-Down Field

In Validation, it is now possible to successfully press Enter twice to confirm the last document in a batch
when it also contains a drop-down field.

892661 - Page Thumbnails Missing in Document Review with SecurityBoost

Page Thumbnails are now displayed in Document Review when SecurityBoost is used.

717467 - Automatic Update for Dictionaries Not Working

Dictionaries are now updated automatically at the start of each new batch when processed by Server, or
opened in Validation, or Correction. This ensures that the most recent information is used to process and
validate documents.

Note This automatic update feature works slightly different for the Thin Clients. To ensure that combo
boxes populated by dictionaries are regularly synchronized, an addition web.config setting is required

to replicate the above behavior. Without this setting, a combo box is filled once and then used as long
as that project is cashed. This means that combo boxes are updated once for multiple batches using
the same project. For more information on the new ForceDictionaryUpdate web.config option, see the
Updates for Thin Client Server Installation Guide.

Dictionaries that are referenced by validation rules are successfully updated, regardless of the
web.config option.

899943 - Poor OCR Results for Visible Dates with FineReader 11.1

A fix for page analysis was provided by ABBYY.

The OCR now successfully find two date values when they are located directly above and below each
other on a document.

Issues Resolved in Thin Client Server

The following issues were resolved in the Thin Client Server.

906496 - Thin Client Validation Hangs Merging Folders

Thin Client Validation no longer hangs when trying to merge a folder to the previous folder.

10
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843807 - Integrated Pipeline Error

Any errors generated by the Thin Client Server are now successfully transmitted and displayed by the
Thin Clients, regardless of what IIS version or pipeline mode, or operating system are used.

733019 - Reclassification via Thin Client Server Script

It is now possible to reclassify a document more than once, by script.

Kofax Transformation Modules 6.1.0 Fix Packs

The following Fix Packs have been released for Kofax Transformation Modules and the Thin Client Server
since 6.1.0 was released.

Kofax Transformation Modules 6.1.0 Fix Pack 14

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 14
(6.1.0.14).

900146 - Custom Subfields Reset After Upgrade

Custom field names that are set in the A2iA Zone Locator are no longer reset. Their names are now
preserved when a project is opened in a newer version of Kofax Transformation Modules.

899324 - Table Interpolation Problem

When interpolating rows of a table in Validation, the first cell is no longer filled with a temporary value.

897310 - Advanced Zone Locator Crashes

The Advanced Zone Locator no longer crashes when certain OMR zones are processed.

890725 - Barcode Locator Failing on Certain Code 39 Bar Codes

A new property is now available for FineReader via scripting and is called
MinRatioToTextHeightBarcode. This property enables you to define a minimum height for a bar code in
relation to the average letter height, and is helpful when detecting low bar codes.

The default value for this setting is 0.5, but if this is not sufficient, you can modify the value.

This property is exposed in CscBarcodeLocator and the range for the setting must between 0.1 and 2.0.
If the value set in script is outside of this range, the values is limited by direction. A number below the
minimum defaults to the lowest possible value of 0.1. Similarly, any value above the maximum value is set
to 2.0.

If the value is set to -1, this means that FineReader adjusts the setting automatically.

1
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884731 - Amount Group Locator Not Extracting Trained Data

The Amount Group Locator now extracts data more accurately.

884462 - Invoice Group Locator Uses Wrong Training Data

The Invoice Group Locator now displays the correct training document.

880773 - Amount Group Locator Returns Incorrect Amount

The amounts returned by the Amount Group Locator are now the expected values.

666410 - Batch.CopyDocument Not Working
No error is generated and a batch is no longer sent to Quality Control when

using the Batch CopyDocument event after a batch class is changed using the
KTM DOCUMENTROUTING NEWBATCHCLASS.

Kofax Transformation Modules 6.1.0 Fix Pack 13

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 13
(6.1.0.13).

884759 - Project Merge Tool Crashes

The Project Merge Tool was fixed to correctly and now successfully merges new validation methods into
another project.

882719 - Database Evaluator Failure

An error is no longer generated when an invalid value is returned during zone recognition.

875525 - Configuration Set Value Overwritten During Project Save

Configuration Set values for the online learning path are no longer overwritten with default values, when a
project is saved.

865996 - Advanced Zone Locator Error

Because text anchoring can contain leading spaces, these blanks are now handled correctly, and an error
is no longer encountered in this scenario.

Kofax Transformation Modules 6.1.0 Fix Pack 12

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 12
(6.1.0.12).

12
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876238 - BeforeExtraction Error

A structured exception error no longer occurs when a PDF with a poor text later containing empty words,
is processed by an Amount Group Locator.

874902 - Visual C++ Redistributable Dependency

There is no longer a dependency on the Visual C++ 2005 Redistributable.

If you no longer want this redistributable, remove it manually because this fix pack does not remove it
automatically.

If you re-install Kofax Transformation Modules using the installer, the redistributable is installed once
again.

836537 - New Batch List Information

The document count and page count are now both available on the Open Batch window.

Note This feature requires that the KofaxCapture-10.2.1.0.FIX6897 or a newer version that includes this
fix is installed.

833954 - Navigating Document Review

When the user selects a new document or page, the Batch Pane automatically scrolls to the selected
document.

Kofax Transformation Modules 6.1.0 Fix Pack 11

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack11 (6.1.0.11).

865623 - Invalid Table Locator Results
The confidences of all executed algorithms are now used for the analysis of cell confidence. Because of

this, the correct confidences are now applied to Table locator results and confident table cells are now
valid as expected in Validation and Thin Client Validation.

865084 - Automatic Table Locator Extraction Problems

When using the Automatic Table Locator, words from one column are no longer included in the extraction
results of another column, regardless of the page number.

835122 - Use All Pages for Training Document

Is now possible to use all pages of a multi-page document for classification training.

This is possible via a new option on the Project Settings - Classification tab.

13
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Under the Content Classification group, a new setting called "Training behavior" is available with the
following options:

+ Train first page only

This value trains the first page of the document. If the first page is excluded from training, it trains the
next available page.

» Train all pages
This value trains all pages of a document, but skips those pages that are excluded from training.

Note You can exclude a page from training via the Thumbnails or Hierarchy view on the Documents tab.

The context-menu option is called "Ignore for Classification and Separation."

578724 - Document Navigation in User Modules

If a Validation or Verification user chooses to cancel a Suspend or Close action, the focus now stays on
the last selected document and does not jump to the first document of the batch.

Kofax Transformation Modules 6.1.0 Fix Pack 10

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 10
(6.1.0.10).

801765 - Moving Between Pages with Keyboard Slow

Document Review is now able to keep up when a user uses the keyboard to move from page to page.

775894 - Document Viewer Disappears in Subsequent Batches
This regression was introduced in the Kofax Transformation Modules 6.1.0.9 Fix Pack.

The Document Viewer in Validation no longer disappears and is displayed as expected.

322006 - OK Button Disabled for Search Immediately Database Lookups

The OK button is now enabled when an Immediate Search scripted database lookup returns multiple
results in Validation.

Kofax Transformation Modules 6.1.0 Fix Pack 9

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 9 (6.1.0.9).

764522 - PDF Text Mixes Word Order

PDF text is now handled correctly when using automatic word separation.

14
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761696 - Intermittent De-Initialization Error

The de-initialization of parent script objects in Server with active child objects has been fixed and this error
no longer occurs.

761409 - PDF Text Imported Incorrectly

PDF text is now correctly imported because double-characters are correctly imported.

754908 - Conflict Resolution Reports Excessive Non-Conflicts

Excessive conflicts in Project Builder no longer occur because the Amount Group Locator no longer treats
valid currency fields as a conflict.

754870 - Invalid PDF Text Layer causes Invoice Group Locator Errors

The Invoice Group Locator is now able to handle "empty” words. As a result, the Invoice Group Locator no
longer fails for these PDF text layers that were previously considered invalid.

749028 - PDF417 Bar Codes not Recognized

The FineReader recognition engine is now updated, and PDF417 bar codes are successfully recognized
by the Bar Code Locator.

747163 - OCR in PDFs is Rotated 90° while Image is not Rotated

The orientation of the PDF text layer is now rotated in accordance with the image.

746923 - Performance Issues when Loading Kofax Capture Fields

Loading Kofax Capture fields now behaves and performs as expected.

746442 - Table Locator Extraction Training Data Not Saved

Table Locator extraction training data is now preserved when reloading the project.

745641 - Image Cleanup Causes Errors

An error no longer occurs when an Advanced Zone Locator with MICR lines use the "Remove Lines"
image cleanup method.

745243 - Previous Document Field Values Shown in Validation
When you close or suspend a batch and the next batch is entirely valid, the validation form and the

Document Viewer no longer display the last document of the previous batch. This means the user can no
longer see a document and its values from the previous batch.

15
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738691 - Cannot Merge Documents that are not Neighbors
In Document Review, multi-selection using Shift + Arrow keys is now working as expected.

For non-neighboring documents, a "Mark Mode" was added that allows users to mark multiple documents
and handle them like selected documents.

The "Mark Mode" is enabled via the View menu and its state is displayed in the Status bar.

This mode displays check boxes on the document level to mark documents. The default key to enable the
checkbox is the Space key.

Note As long as no documents are selected in while in "Mark Mode", document selection behaves as
normal.

If a user goes into "Mark Mode" when other documents are already selected, that selection is lost.

You can override the default shortcuts via the project settings.

737516 - Option to Disable Rotate Warning in Document Review

A check box is now available in the message window that allows users to disable the rotate warning
message.

731715 - Restrict Single Logon Session per Module

Users are now restricted to a single logon session per module.

Important In order for this fix to work, you also need Kofax Capture 10.2.0.5 and Kofax Capture
10.2.0.5.FIX6023 or a later version that includes this fix.

727250 - Additional Document Review Menu Options

The following menu options are now available for multi-page documents as well as the entire batch.
» Copy Page to New Document

* Rotate 180°

» Rotate All Pages of Document to the Left

* Rotate All Pages of Document to the Right

» Rotate All Pages of Document 180°

* Rotate All Pages of Batch to the Left

» Rotate All Pages of Batch to the Right

* Rotate All Pages of Batch 180°

712663 - Highlight All Lassoed Words in Document Viewer

Highlighting is now continuously active when navigating between pages in the viewer window in
Validation.

16
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712524 - Server Scheduler Service Rights and Permissions

It is recommended to run Server Scheduler Service with administrative rights.

However, if the following requirements are met, the Server Scheduler Service and its dependent
processes can run without administrative rights.

When choosing a user account to run the Server Scheduler Service, the following are important:
» The standard guest user does not work.

* You can use a standard user.

* You can use a standard user and move them from the standard user group to the guest group.

SecurityBoost:

* When using SecurityBoost, the Server Scheduler Service user should be the SecurityBoost user, or at
least have equivalent privileges.

Kofax Transformation Modules 6.1.0 Fix Pack 8

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 8 (6.1.0.8).

735129 - Verification Crashes in APP-V 5.1 Environment

The Verification module no longer crashes when running in an APP-V 5.1 environment.

733569 - Validation Hangs when Opening Multiple Instances

When multiple instances of Validation are opened quickly, it is no longer likely for one or more of these
instances to lock up.

733423 - Server Scheduler Server Crashes

Additional checks are now carried out by the Scheduler Service to prevent crashing.

728453 - Ability to Move Logs to New Log Path

Kofax Reporting has been upgraded to version 2.0.2. This enables you to specify a different path for the
reporting log.

724221 - PDF Documents not Displayed Correctly

PDF documents are now rendered as expected.

717553 - Error with Many Documents and Trainable Document Separation

It is now possible to successfully process a large amount of documents using a project with Trainable
Document Separation.
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701346 - A2iA CheckReader Cannot Extract a Zero Amount

The amounts on zero dollar checks ($0.00) are now properly extracted.

701345 - A2iA CheckReader Error

The A2iA CheckReader now successfully processes Checks without error.

687698 - Database Locator Fails to Find Values

The Database Locator no longer excludes valid alternatives during extraction. Because of this, values are
successfully found by the Database Locator as expected.

676240 - View Average Time Spent Validating a Document

The user focus time for each document per module and is now measured and reported as
ProcessingTime to Kofax Capture, when supported by Kofax Capture.

The user modules that support this new reporting feature are Document Review, Correction, Validation,
Verification, Thin Client Correction, Thin Client Validation, and Thin Client Verification.

670164 - Identify Fields Changed by User vs. System

When a field is modified the source of that modification is recorded and available when using KAFC.
Fields can be modified by the user or by the system, this includes database lookups and scripts.

284721 - Improve Batch Deletion in User Modules

A new setting in the Extended Synchronization Settings window is now available so that you can configure
a batch class to delete an empty batch when closed.

Note Enabling this setting can cause problems if you are using partial batch release. A workaround is to
use document routing to move all of your documents to other batches and then delete the empty batch
that is left over.

Kofax Transformation Modules 6.1.0 Fix Pack 7

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 7 (6.1.0.7).

711355 - Extensive Use of External Knowledge Bases Memory Problems

Training information from the Knowledge Bases is now stored in cache to reduce memory consumption.

706845 - Doubled Characters from PDF Text Imports

A PDF with embedded text is now extracted once only, ensuring that there are no duplicate characters.
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705905 - Application_InitializeBatch Property Not Working

You can now successfully use the CscClass.ShowInKeyingModules property in Document Review and
Validation as expected.

697577 - Purple Highlighting for Related Text not Working

When a field for a Trainable Group Locator is selected in the Edit Document window, related keywords are
once again highlighted purple.

695711 - Add Ability to Expand All Documents when Opening Document
Review

A new value for the "Document display behavior" option on the Batch settings tab in the Document Review
Setting window is now available.

Batches can now be configured so that all documents are expanded automatically when the batch is
opened.

Kofax Transformation Modules 6.1.0 Fix Pack 6

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 6 (6.1.0.6).

692795 - ReliableFileSystem Element in ACConfig Ignored

High Availability now performs as expected in Document Review.

691555 - Embedded PDF Text not Read Correctly

PDFs with embedded text are now processed and extracted as expected.

688759 - Window Position and Viewer Settings not Remembered in
Document Review

The size and position of Document Review and its docked Viewer within the window, are now retained
when a user closes the application. If the Viewer is floated, its position reverts to the default docked state.

Kofax Transformation Modules 6.1.0 Fix Pack 5

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 5 (6.1.0.5).

694166 - Database Locator Error with Encrypted Database

Using a large encrypted database no longer causes an exception error.

19



Kofax Transformation Modules Release Notes

689220 - Data Extracted Twice for PDF Text Layer

When a PDF document is processed, data is extracted only once as expected.

687169 - Error with Microsoft Text ODBC for CSV Files

A problem no longer occurs when using the Microsoft Text ODBC driver to process *.csv files.

670164 - Identify Fields Changed by User vs. System

When a field is modified the source of that modification is recorded and available when using KAFC.

Fields can be modified by the user or by the system, this includes database lookups and scripts.

667014 - A2iA CheckReader Allows Unlicensed Settings

It is no longer possible to configure unlicensed settings when using the A2iA CheckReader.

606702 - AfterFieldChanged Not Called in InPlace Editor

The InPlace Editor is now reacting on the AfterFieldChanged event.

Kofax Transformation Modules 6.1.0 Fix Pack 4

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.4).

688993 - Document Review Crashes on Close

Document Review no longer crashes when closed.

686170 - PDF Orientation not Displayed Correctly in XDoc Browser

A PDF document is now displayed with the correct orientation in the XDoc Browser.

682803 - KTM for Forms Project Uses KTM Unlimited Page Count

When the KTM for Forms license is applied, the page count for other licenses is no longer consumed
when a project uses ‘basic features’ only.

633494 - Add Session Timeout for User Modules

Kofax Transformation Modules now supports a session time out feature that was implemented in Kofax
Capture. The affected user modules are Correction, Document Review, Validation (1-5), and Verification.

This feature is available only if you have Kofax Capture 10.1.1.5 with Hotfix 4841 installed. The "Time
out after inactivity of X minutes" option is configured in Kofax Capture Administration, under Tools >
Profiles > Edit a user or group.

20



Kofax Transformation Modules Release Notes

To ensure you have access to this feature in the user modules, follow these steps:
1. Open Kofax Capture Administration.

2. Go to Tools > Custom Modules.
The Custom Modules Manger window is displayed, listing all of the existing modules.

Note Do not delete any modules before adding them again. You only have to update KTM
Correction, KTM Document Review, KTM Validation (1-5), and KTM Verification.

Click Add and select a user module, and then click Install.

Repeat until all affected user modules are reinstalled.

Kofax Transformation Modules 6.1.0 Fix Pack 3

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 3 (6.1.0.3).

671100 - Document Routing Fails for Locked PDFs

PDF files are no longer locked to another process when document routing is performed.

669745 - Validation Does Not Release the Handle to the Batch

When a batch in Validation is closed, all handles to the batch are successfully released.

Kofax Transformation Modules 6.1.0 Fix Pack 2

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 2 (6.1.0.2).

663426 - Project Builder Shortcut Keys not Working on Russian System

All ribbon shortcuts are available when using the Russian language pack for all Kofax Transformation
Modules modules and applications.

The algorithm used to generate shortcut keys has been improved. Characters with diacritical marks are no
longer used as shortcut keys.

656954 - Shortcut Keys not Working with Japanese Language Pack

Shortcut keys now work as expected, even when using the Japanese language pack.

656882 - XValues Not Always Loaded

XValues are now always available for document sets when an Extraction Benchmark is performed.

652721 - Bar Code Types Not Available

The Patch, Post Net, UCC 128 and UPC-A bar code types can now be successfully assigned to a Bar
Code Locator.
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648779 - Structured Exception when Configuring an SQL Database

During configuration in Project Builder, databases with a large number of tables no longer causes
problems.

Bugs 648770 and 643166 were fixed as a result of this bug.

642141 - Bar Code Settings Change
When a project is upgraded from Kofax Transformation Modules 6.0 to version 6.1, a Bar Code locator

that was configured to use the “Data Matrix” type is now configured to use the “UCC 128" bar code type
instead.

This configuration change improves the recognition of this bar code type.

612972 - Classify Document in Project Builder Takes Long Time

The performance of the "Classify Selection" option in Document Viewer has been improved. Testing
classification in Project Builder no longer takes a long time when there are complex Instructions.

365468 - Database Locator Returns Encrypted Records

The Database Locator now decrypts more entries before post-processing occurs. This ensures that the
best result is returned.

Kofax Transformation Modules 6.1.0 Fix Pack 1

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 1 (6.1.0.1).

641142 - Purchase Order Discovery Takes a Long Time

It no longer takes a long time to process documents that have a lot of open purchase orders in the
database when the Line Item Matching Locator is doing purchase order discovery for an Oracle database.

635996 - Could Not Open File

Kofax Transformation Modules can successfully load and save XDocuments back to Kofax Capture
because the Reliable File System, also known as High Availability, is now supported for the failing action.

635928 - Keyword Highlighting Fails in Edit Fields Window

Keyword highlighting is now working as expected in the Edit Fields window.

633875 - Field Validation Rules Run in Document Review when no Field
Data

Field Validation rules are no longer executed if batch editing actions such as splitting a document, are
performed in Document Review.
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630564 - Web Dictionaries and Databases Cannot be Used

It is now possible to successfully add a dictionary or import a fuzzy database using a remote URL.

627636 - Database Locator Word Confidences

When hovering over a field value, the confidence for each individual field is now displayed within the
Database Locator window on the Results tab.

The value of this confidence can be accessed in script using the following:

pXDoc.Locators.ItemByName ("DatabaselLocatorName") .Alternatives.ItemByIndex
(AlternativeIndex) .SubFields.ItemByIndex (SubFieldIndex) .IndividualConfidence

This value has been added for scripting purposes only. It does not affect the confidence of the fields filled
by the Database Locator.

627743 - Database Locator Issue When Duplicate Words Appear in Same
Row

A new setting is now available for the Database Locator. The new Maximum distance to concatenate
numbers (mm) option is located on the General tab and enables users to specify the maximum distance
in millimeters for which separated digits or numbers in the text representation are considered part of the
same number. Characters that are located outside of this maximum distance are recognized as distinct
numbers.

Note This works only for numerical characters.

624316 - Different Classification Results for Project Builder and Runtime

The classification results seen when testing documents in Project Builder now match the classification
results returned during production.

619858 - Advanced Zone Locator Subfields Ignored

Advanced Zone Locator subfields are now successfully mapped to group member zones, even if anchor
registration fails.

618789 - Project Builder Crashes During FineReader Page or Zone
Recognition

Project Builder no longer crashes when a large dictionary is added to a FineReader Page or Zone profile.

613080 - Validation Crashes with Character Exact Editing is Enabled

For new batches, Character Exact Editing is now working as expected when the Always CAPITAL letters
option is enabled.
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607505 - Classification Instructions Missing Horizontal Scrollbar

The scrollbars are now available when viewing classification instructions.

607497 - Classification Instructions not Sorted in Alphabetical Order

Classification Instructions are now sorted in alphabetical order.

607495 - Cannot Edit OCR Text in Document Viewer

It is now possible to edit and save the OCR text for some documents in the Documents window. The save
button is enabled for documents in the Classification Set only.

606480 - Validation Rule Creation Failure

A conditional check has been added in the code to ensure that inherited Validation Rules are no longer
deleted erroneously.

562157 - Unable to Import or Export Classification Instructions

It is now possible to successfully import and export classification instructions.
The import / export tools are available only when the 'Instructions’ element is selected.

The following behavior is available for instructions.
* The Import As New option appends the imported instructions to the selected locator class.

» The Import option deletes any existing instructions for the selected locator class before importing the
new instructions.

» The Export option is available only when there is at least one instruction in the selected class. Save the
exported instructions for import elsewhere.

The behavior of importing and exporting locators was also affected by these changes.

* The Import As New option will append the imported locator to the selected locator class and will be
available only when the Locators element is selected in the project tree.

* The Import option will overwrite the selected locator. This option is available only when a locator is
selected in the Project Tree.

» The Export option is available only when a locator that has an extraction method is selected in the
Project Tree. Save the exported locator for import elsewhere.

271125 - Allow Modification of Class Properties at Runtime

Portions of the cscclass object are now supported by Kofax Transformation Modules.

The supported object and properties are as follows.
* CscClass

* CscClass.ShowInKeyingModules - Specifies if this class is to be shown in the re-classification
combo box in Validation and Document Review.
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* CscClass.ValidClassificationResult - Specifies if this class is a valid classification result.

These properties can be used in the following script events.
* Application InitializeScript
* Application InitializeBatch

* Batch Open

Thin Client Server 6.1.0 Fix Pack 11

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 11 (6.1.0.11).

Thin Client Server 6.1.0 Fix Pack 10

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 10 (6.1.0.10).

766535 - Table Cell Script Changes Failing in Thin Client Validation

The row selection and updating values in multiple tables, now work as expected.

799987 - Wrong Error Message with Incorrect Password

The correct error message is now displayed when a user enters an incorrect username or password into
one of the Thin Client modules.

800694 - Monitor for Automatic Learning ignored by Thin Clients

The "Monitor for Automatic Learning" field setting is now supported by Thin Client Validation.

As a result, a monitored field that is modified during Thin Client Validation is automatically trained for
extraction online learning.

867562 - Space Character Finds no Results in Database Search

Search results are now returned successfully when a space character is used in a database lookup.

Thin Client Server 6.1.0 Fix Pack 9

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 9 (6.1.0.9).

647080 - Multiple Application Vulnerability on Thin Client Server

Output encoding has been implemented in Thin Clients, resolving an application vulnerability.

Batch logging has been added to the Thin Clients. This needs to be configured in Web.config file,
KCThinClientModule.exe.config file and KTM ExtendedLogging system variable.

707945 - Database Lookup has Un-Encoded Field Data

Encoding has been implemented for database lookups.
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707947 - Rejected Notes Not Encrypted

Encoding has been implemented for Sticky Notes that are rejected.

710809 - Error Displaying Image during Thin Client Validation

Images are now correctly displayed during Thin Client Validation.

714076 - Better Error Messages when Leaving or Refreshing Page

Forced page refresh via F5 is now suppressed by Thin Client Server for Internet Explorer version 9, 10
and 11 and Firefox.

746224 - Average Time Spent on Document not Updated

Added logic to update the time span and keystrokes in the xfd file. ProcessingTime is now updated
correctly in Kofax Capture for Thin Client Correction.

747146 - Thin Client ApplicationPool Process Memory Leak

There is no longer a memory leak with the ApplicationPool process.

748277 - Classification Result Column Constantly Loading

The classification results are no longer constantly loading.

756030 - Database Connections Do Not Close with Batch

Database connections are now closed when unloading the project from Thin Client Validation. This either
happens when a different project is loaded or when the database timeout is hit (as defined in the DB
connection string).

In addition only one connection per database that is used on a database lookup button is opened during
project load and kept open until the project is closed.

763830 - Image Viewer and Index Fields not Updated

The folder index calculation was fixed to work with updated browsers versions, so that page and fields are
now displayed as expected.

Thin Client Server 6.1.0 Fix Pack 8

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 8 (6.1.0.8).

671033 - Identify Fields Changed by Thin Client User vs. System

When a field is modified the source of that modification is recorded and available when using KAFC.
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Fields can be modified by the user or by the system, this includes database lookups and scripts.

676240 - Display Average Time Spent Validating a Document

The user focus time for each document per module and is now measured and reported as
ProcessingTime to Kofax Capture, when supported by Kofax Capture.

The Thin Client user modules that support this new reporting feature are Thin Client Correction, Thin
Client Validation, and Thin Client Verification.

692716 - Reporting Fails for the Thin Clients

Reporting now behaves as expected for the Thin Client Server.

711677 - Scroll Position Jumps in Relational Database Lookup Window

The focus on a the selected cell in a lookup window is now retained, without changing the scroll position.

Thin Client Server 6.1.0 Fix Pack 7

The following problem has been resolved in Thin Client Server 6.1.0 Fix Pack 7 (6.1.0.7).

690035 - Field Values Not Displayed Correctly

The Batch Structure view now displays field values when the "Use as Display Field Selection" option is
enabled for that field.

Thin Client Server 6.1.0 Fix Pack 6

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 6 (6.1.0.6).

682150 - Force Valid with Validation Rules Fails in Thin Clients

If a field has a multi-field validation rule, it now possible to successfully force that field valid.

681686 - Force Valid Icon Missing in Thin Client Validation

The Force Valid icon is now displayed as expected when using a combo box.

656750 - Thin Clients are Slow to Open Batches

Batches selected from the batch list are now opened in a timely manner.

Thin Client Server 6.1.0 Fix Pack 2

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 2 (6.1.0.2).
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635346 - Combo Box Cannot be Changed from Script

The JavaScript has been updated to you can now update a combo box from script.

629600 - Right-To-Left not Working in Thin Client Validation

Fields configured for Right-to-Left alignment are now displayed as expected in Thin Client Validation.

Thin Client Server 6.1.0 Fix Pack 1

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 1 (6.1.0.1).

640593 - Combo Box Font Size Mis-match in the Thin Client Validation

The font size applied to a drop-down list in a validation form custom layout in Project Builder is now
displayed correctly in Thin Client Validation.

640288 - AfterSplitDocument Event Issue in Thin Client Validation

The aftersplitbocument eventin Thin Client Validation now works as expected by splitting documents
as requested.

635346 - Document Unconfident but Valid in Thin Client Validation

When a combo box is marked as valid for the first time, the corresponding document no longer needs to
be confirmed a second time.

626911 - Thin Client Validation Needs to Close Empty Batch

Thin Client Validation users are now prompted to delete an empty batch if they attempt to close that batch.

If they do not delete the batch, the only way to move on to the next batch is to suspend the empty batch.

593365 - Memory Problem for Thin Client Server with Large Batches

Thin Client Correction batches that call scripts are no longer sent to Quality Control.

The script engine is now correctly initialized and batches with scripts are processed as expected.
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Chapter 3

Known Issues

The following sections describe known problems, and if available, useful workarounds for Kofax
Transformation Modules 6.1.1.

Root Element Error when Documents Copied via Drag & Drop

When documents are copied via drag & drop, an error can occur when the project is trained or when the
documents are sorted on disk.

Workaround: When presented with this error, press the Ignore or the Ignore All button. Doing so repairs
the defective documents. (630605)

Uninstalling Kofax Transformation Modules 6.1.1

The removal of Kofax Transformation Modules 6.1.1 can fail because the Server Scheduler service does
not always stop in a timely manner when requested by the installer.

Workaround: Stop all Kofax Capture and Kofax Transformation Modules services before attempting an
uninstall. (619511)

Clear Thin Client Browser History

After an upgrade, certain Thin Client features do not work as expected.

Workaround: Clear the browser history and then restart IIS.
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Chapter 4

Additional Documentation

The following sections provide additional documentation for new features available in Kofax
Transformation Modules 6.1.1, that is not available in existing documentation.

Help Updates for Project Builder

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
* Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

The following topics are obsolete from this Service Pack forward and will no longer appear in the next full
release of this product.

« Set Up Document Review > The Document Review Log File
» Set Up Correction > Understand the Log File

« Set Up Validation > Understand the Validation Log File

» Set Up Verification > Understand the Verification Log File

Updated: Field Property Change History

A new option is available on the Project Settings - General tab. When selected, any changes to field
properties during extraction are saved and recorded in a history that is available for viewing at a later time.
The new setting is as follows.

Monitoring
This group has the following option:
Save field property change history

Select this option so that any changes made to field properties during extraction are recorded and
available in the Extraction Results and the XDoc Browser.

This option is cleared by default.

Important Selecting this option may increase processing times. As a result, it is recommended to
select this option if you are interested in the field results only.
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New: Property Change History Window

This window displays a read-only overview of the changes made to a subset of the properties for a field
during extraction. This information is stored in the XDocument.

Review this history to view details about the extraction of this field.

You can access this window via the Extraction Results window only. Alternatively, similar information is
available in the XDoc Browser.

Important This window is available only when the "Save field property change history" setting is
selected in the Project Settings - General Tab.

The following columns are available for each change.

Class
The name of the class that is executing the current change.

Note For script events, it is possible that the class name changes due to script inheritance.

Scope
The name of the script event or the name of the processing step.

Source
The source of the process change. This value is either "Processing" or "Script."

Property "Text"
The extracted result for the field.

Property "Confidence"
The confidence of the extracted result.

Property "Valid"

Indicates if the extracted result is valid or not. True is returned for a valid result and False is returned for
an invalid result.

Property "Preserve”

If this value is set to "True," the field is not cleared if a document is reclassified and its value is not
changed by the defined locator in the new class. Only formatting may be applied.

When this value is set to "False," the field can be extracted once again.

Property "ExtractionConfident"

Indicates if the extracted result is confident or not. True is returned for a confident result and False is
returned for a result that is not confident.

Property "ErrorDescription”
The description of the error encountered, if any.
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Updated: Extraction Results - New Column
A new column is available for the Extraction Results. This new column is as follows.

History

Displays an information button [fJ that opens the Extraction Debugging Log window when clicked. This
window contains information about any field property changes that occurred during extraction.

Updated: Database Locator Properties Window - General Tab

The description of the "Select a database with records that should not be found by this locator (e.g. own
addresses)" setting has changed as follows.

Select a database with records that should not be found by this locator (e.g. own addresses)

If necessary, select a database that contains records that should exclude detected values from the list of
alternatives. If one of these values is found on the document, it is excluded from the final extraction result
for this locator. This type of database is commonly referred to as an exclusion database.

The value for this option is set to <none> by default.

Note The "Locator Algorithm Properties" on this window do not apply to this exclusion database.
Instead, there is a pre-defined 80% minimum confidence threshold that cannot be modified. All
alternatives in an exclusion database search that have at least an 80% confidence are excluded from
the main database search. You can adjust how the confidence is calculated for this database on its
individual database properties window accessible from the Project Settings - Databases tab.

Updated: Database Locator

A new procedure was added to the list management tasks for a Database Locator as follows.
* Add an exclusion database

Important The settings for this locator do not apply to the exclusion database and in order for a
search result to be excluded, the alternative must have at least an 80% confidence.

New: Exclusion Database

An exclusion database enables you to exclude certain entries in your main database that may be

returned by a search. For example, if you are searching for a vendor on an invoice, there may be multiple
addresses that relate to that vendor. You can set up an exclusion database that contains any irrelevant
addresses and apply it to the "Select a database with records that should not be found by this locator (e.g.
own addresses)" setting on the General tab of the Database Locator Properties window.

When a Database Locator is executed, the exclusion database is run first. Any search results that are
returned with at least an 80% confidence are excluded from the main database when its search is
performed.
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When setting up an exclusion database, note the following.
* The exclusion database does not need to contain the same columns as the main database.
* The 80% confidence minimum requirement cannot be modified.

» The database should only contain columns that appear on the document. If additional columns are
present, the 80% confidence minimum is unlikely to be met.

« The exclusion database must have at least three columns defined.
» The confidence of the alternatives is not displayed.

» The fields in the exclusion database should be physically close together on the document. This
increases the chance of a higher confidence result.

Note The fields that are defined as "Field present on document" within the Fuzzy Database Properties
window need to be physically close together on the document.

A match for your own address is only excluded from main database search if its confidence is higher than
80%. As fields that are not found on the document lower the confidence for the match, you cannot select
any fields that are not present on the document.

New: Adjust Exclusion Database Settings

The exclusion database that is configured on the Database Locator Properties window is not affected by
any of the other settings on that same window. It also has a minimum confidence of 80% that you cannot
modify. This confidence is not related to the "Minimum confidence" configured in the Database Locator
itself.

If you need to increase the chance of reaching the 80% confidence threshold, it is possible to manipulate
how the confidence is calculated. You can do this by selecting or clearing specific fields in the exclusion
database properties by following these steps:

1. On the Project tab, in the Configuration group, select Project Settings .

2. Click on the Databases tab.
A list of databases used in your project is displayed.

3. Locate your exclusion database in the list and click 5 Properties.
The properties window for the selected database is displayed.

4. Inthe Field Names panel, clear any fields that are not needed. Similarly, select any fields that are
required.
When searching for a specific vendor address, clear fields that do not help narrow the results. This
includes fields that do not appear on the document, or those that are not relevant. For example,
if all of your vendors are in the same country, the "Country" field can be cleared. Similarly, if your
exclusion database includes ID fields or customer numbers that do not appear on the printed
document, clear these fields as well. Clearing fields that contain irrelevant data can increase the
confidence of a match, ensuring that your exclusion database performs more effectively.

5. Click OK.
The database properties window closes.

Updated: Reclassification of Documents

This topic will be updated as follows in the next full release.
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You can change the classification result [ of a document in script by calling the Reclassify method.

You can use either of the Project Class extraction events for unclassified documents. These events are
executed before document classification. When using the class extraction events, extraction is stopped for
this class and then executed for the new class. For more information, refer to Reclassify Documents via
Script in the Scripting Help.

Locators, fields, and validation rules are available for configuration when the corresponding class is
selected in the Project Tree.

New: Access Rights for a Microsoft SQL Server Database

Several permissions in the Microsoft SQL Server database are required by Kofax Search and Matching
Server on the fuzzy database source. These permissions are necessary in order to access tables, views,
synonyms, and stored procedures.
At a minimum, the Server login requires the following permissions.
* CONNECT SQL
* VIEW ANY DATABASE
* VIEW ANY DEFINITION
This permission is required by the sp_databases stored procedure that is used to list the databases
that are accessible to the logged on user.

The following permissions are also required by the "database role" or "user" for each relational object.
* SELECT
This is required to access views, tables, and synonyms based on a view or table.

Updated: Image Files

Image Files has been modified by adding the following content to the beginning of the topic.

The size of an image must be between the ISO A6 and A2 paper sizes. This means that images must be
at least 105 mm x 148 mm (4.1 x 5.8 inches) and at most 420 mm x 594 mm (16.5 x 23.4 inches).

New: Log Files

Kofax Transformation Modules records several types of logs that help you understand what is happening
during production.

These logs are useful when troubleshooting things that are not behaving as expected.

The logs are separated into two distinct categories.

1. Application logs.

You can control these logs using the Server Configuration Tool for several interactive and non-
interactive modules.

2. Batch-level logs.
These logs are generated automatically. There is no configuration necessary.
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New: Application Log Files

Log files contain information about various modules while in production. The log files contain different
levels of information, depending on how they are configured. Each log file is a text file, with tab-separated
data so it can be opened in a spreadsheet application such as Microsoft Excel.

The location of the log files is configurable in the Service Configuration window.

The name of a log file includes the name of the module, the date, and an instance number, if applicable.
This means that if there are several instances of Validation enabled for a project, the name of the

log file includes this instance number. For example, KTM validation#1 2017 07 31.txt and

KTM Correction 2017 07 31.txt.

However, if you are using two instances of Server, these are not separated into separate log files. The
individual iteration numbers are recorded in a single log file.

You can generate application log files for the following applications.
» Correction

* Document Review

» Knowledge Base Learning Server

» Scheduler (Server Scheduler)

» Server

» Validation

* Verification

New: Application Log File Contents
The tab-separated columns of information in each log file are static, and therefore, not configurable.

However, the information contained in these log files is very comprehensive, so you are able to easily
navigate the files, and troubleshoot any issues.

Each log file contains the following columns.
* Time.

The time and date of processing. Since processing can span across a single day, this date may be
different to the date in the log file name.

* Level.

The configured level of detail included in the log. Depending on how your log files are configured, this
can be any of the following values.

» "Error." Records error events that may allow the application to continue running.
» "Warning." Records potentially harmful situations.

» "Info." Records informational messages that highlight the progress of the application at a detailed
level.

» "Debug." Records fine-grained informational events that are used to troubleshoot and debug the
application.

* ProcId.
The process ID of the application.
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* Memory (KB).
The amount of memory used by the ProcessId.

* Message (Class.Method).
The Message is information about the log entry. If there is an error, it is logged here.
The cl1ass and Method indicate the origin of a particular log entry.

All three of these help identify what is causing a problem, and at what point during processing the issue
occurs.

Each of the above log files is retained for a period of days configured by the "Purge log entries older than
(days)" option in the Configuration Tool window.

The Thin Client Server log file is slightly different than the rest of the log files. Firstly, the Thin Client
Server log file is not configured in the same Configuration Tool as the rest of the log files. Instead, it

is configured via the Thin Client Server configuration files. For more information, see the Thin Client
Server Installation Guide. Secondly, all of the other log files include data for a single module. The Thin
Client Server however, contains data from Thin Client Correction, Thin Client Verification, and Thin Client
Validation. Because of this, the following two additional columns are available in this log file.

* Module.

This is the name of the individual Thin Client module. This can be Thin Client Correction, Thin Client
Verification, or Thin Client Validation.

* Username.

The name of the user using the corresponding Thin Client module.

With this additional information, you can see which of the Thin Clients generates a log entry along with the
individual user.

New: Batch-Level Log Files

These logs are generated automatically alongside every batch that is processed through Kofax
Transformation Modules. The log files are stored in the same location as your image files. For example, c:
\ProgramData\Kofax\Capture\Images\0000030D\Log.

These logs contain every event and processing step that occurs in an entire batch. The application log
files record information about a single module only, and the steps it takes to process documents. Both logs
contain valuable troubleshooting information.

The following modules generate batch log files to record batch-level events.
» Correction

* Document Review

» Validation

* Verification

The name of a log file includes the name of the module and the batch number.

A shortened module name is included in the batch-level log filename so that you know which log file is for
a specific module. The names used are cor for Correction, pr for Document Review, vat for Validation, or
VER for Verification.

The batch-level log filename structure is as follows.
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KTM<MODULE> <BatchID>.txt.

If there are several steps of Validation enabled for a project, each step generates its own log file for that
batch. For example, KTMVAL#1 000000364 .txt and KTMVAL#2 000000364.txt.

Among other processing events, the batch-level logs files can include the following events.
* ValidationForm DocumentLoaded

* Batch Open

* Batch Close

* Application Initialize

* Application Deinitialize

These batch-level log files are tab-separated. This means that you can open a log file in a spreadsheet
application such as Microsoft Excel. The structure of the tabs is static and cannot be configured or
changed. The following information is included in each batch-level log.

* Time.

The time and date of processing. Since processing can span across a single day, this date may be
different to the date in the log file name.

* Level.

The configured level of detail included in the log. Depending on how your log files are configured, this
can be any of the following values.

» "Error." Records error events that may allow the application to continue running.
* "Warning." Records potentially harmful situations.

» "Info." Records informational messages that highlight the progress of the application at a detailed
level.

» "Debug." Records fine-grained informational events that are used to troubleshoot and debug the
application.

* ProclId.
The process ID of the application.
* Memory (KB).
The amount of memory used by the ProcessId.
* Message (Class.Method).
The Message is information about the log entry. If there is an error, it is logged here.
The class and Method indicate the origin of a particular log entry.

All three of these help identify what is causing a problem, and at what point during processing the issue
occurs.

The log level matches the value you assigned to the corresponding application log in the Service
Configuration Tool. For example, if you configure the Validation application log to record logs with the
"Warning" level, then the batch-level Validation log also records events at the "Warning" level. Similarly, if
you configure the Document Review application log to record logs with the "Debug" level, then the batch-
level Document Review log also records at the "Debug" level.

For more information about the Service Configuration Tool and its options, see the Help for Server,
Knowledge Base Learning Server, and Services.
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Important Once a batch is deleted, the log files are deleted along with the batch.

New: SecurityBoost

SecurityBoost is a Kofax Capture feature that enhances security by restricting access to the Kofax
Capture image folder.

A SecurityBoost user is configured to access the image folder in several user modules.

All SecurityBoost configuration is done in Kofax Capture. In order to use SecurityBoost within Kofax
Transformation Modules, no additional configuration is required.

For more information on using and configuring SecurityBoost, see the Kofax Capture Help.

New: SecurityBoost Modules

When enabled in Kofax Capture, the following modules use the SecurityBoost feature.
* Document Review

» Correction / Thin Client Correction

» Validation / Thin Client Validation

» Verification / Thin Client Verification

» Server

When the SecurityBoost feature is enabled, these modules and their processes are opened in the context
of the logged on user in the same manner that they would if SecurityBoost was disabled. All reporting and
logging is recorded for the logged on user.

Because access to the images in the Kofax Capture image folder with SecurityBoost is prohibited for
operators or other non administrator users, the permissions granted to the special SecurityBoost user are
used instead of those granted to the logged on operator.

Updated: Dictionary Options Window

The following option description has changed in the Dictionary Options window. This new description will
be available in the documentation at the next full release of Kofax Transformation Modules.

Automatic update from import file

Select this option to synchronize your imported dictionary file with its source dictionary whenever a batch
is opened by one of the following modules.

+ Server

+ Validation

+ Correction

This means that any changes in the source dictionary are reflected in your imported dictionary file when

any of the above modules is run. These automatic updates are then available for processing during those
modules.

It is recommended to enable this option only if your source dictionary is updated regularly. Otherwise, the
unnecessary update checks may hinder performance. This option is cleared by default.
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Important This automatic update feature works slightly different for the Thin Clients. To ensure that
combo boxes populated by dictionaries are regularly synchronized, an additional Thin Clients web.config
setting is required to replicate the above behavior. Without this setting, a combo box is filled once and
used as long as that project is cashed. This means that combo boxes are updated once for multiple
batches using the same project. For more information on the new ForceDictionaryUpdate web.config
option, see the Thin Client Server Installation Guide.

Dictionaries referenced by validation rules are successfully updated, regardless of the web.config option.

Updated: Configure a Dictionary to Update Automatically

The introduction of this task topic has been updated as follows.

If the source file used for a dictionary is modified frequently, configure the dictionary so that it is updated
automatically when the import file changes. This means that each time a batch is opened by Server,
Validation, Correction, the source dictionary is checked for modifications. If any changes are present, your
local copy is updated to match the source dictionary.

Important This automatic update feature works slightly different for the Thin Clients. To ensure that
combo boxes populated by dictionaries are regularly synchronized, an additional Thin Clients web.config
setting is required to replicate the above behavior. Without this setting, a combo box is filled once and
used as long as that project is cashed. This means that combo boxes are updated once for multiple
batches using the same project. For more information on the new ForcebDictionaryUpdate web.config
option, see the Thin Client Server Installation Guide.

Dictionaries referenced by validation rules are successfully updated, regardless of the web.config option.

Updated: Script Code Window

The contents of this window have been updated as follows.

Use this window to edit scripts with the WinWrap Basic Editor. This is an interactive environment for
developing, testing, and executing WinWrap Basic scripts.

The editor contains both a menu bar and a toolbar. Descriptions for most of these options is included in
the WinWrap Basic Editor Help.

Select the Editor Help from the Help menu to get more information about the script editor and its user
interface. Select Language Help from the Help menu to get more information about the WinWrap
Basic language. Select Script Documentation from the Help menu to get more information about script
programming and CASCADE objects.

The following menu and options are not included in the WinWrap Basic Editor Help.

Tools
This menu has the following options.
Clear All Scripts from Project
Removes all scripts from all classes and folders, as well as all references from the scripts.
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Save All Scripts

Saves all scripts to a user-specified location so that they can be viewed outside of Project Builder.
This includes folder scripts, class scripts, and the main project script.

Use these options when troubleshooting scripting issues in your project.

The Object list right beneath the toolbar provide the following:

Object
The Object list shows all the objects for the current module.
Proc

The Proc list shows all the procedures or events for the currently selected object. Selecting an item from
the proc list that is not bold inserts the proper procedure definition for that procedure into the code area.

Additionally, the editor has different tabs that are vertically arranged down the left side of the window.
Each tab consists of an edit area used to insert script code and a band on the left to place breakpoints.

Before you start entering code you have to select the correct sheet. The project script is always opened as
the first sheet (tab 1). The window caption of this sheet is Project - Script Code. For example, in this sheet
you can implement a field formatting procedure or a script validation method. All public defined functions
or methods in this sheet are available in all other sheets.

For each class and for each folder a script sheet is inserted by selecting Show Script from the shortcut
menu of a class or a folder class. In these sheets the internal methods of the class can be implemented.

Help Updates for Server, Knowledge Base Learning Server, and
Services

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
* Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

The following topics are obsolete from this Service Pack forward and will no longer appear in the next full
release of this product.

* Process Batches with Knowledge Base Learning Server > Understanding the Log File
* Process Batches with Server > Understanding the Log File
* Process Batches with Server > Using Advanced Options > Registry Keys

Updated: Service Configuration User Interface

You can use the Service Configuration window to change settings for the Server and Knowledge Base
Learning Server services.
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Log On Account for Services

Important Be sure that the log on account used to run the services has full Windows administrative
privileges for the local system.

To process documents from a network drive, make sure that the log on account provides network access.
Otherwise, processing stops and an error message is added to the error log file.

If the SecurityBoost feature is enabled within Kofax Capture, a process may run as a different user than
the logged on user. As a result, correct permissions may need to be set for the SecurityBoost user in the
Windows Services window.

This group has the following options.
Server Scheduler Service

This is a read-only setting that displays the name of the logged on user account for the Server
Scheduler.

In the Server Scheduler Service group, you can define the performance settings for this service by
adjusting the number of used CPUs and the value of the maximum memory available.

Knowledge Base Learning Service

This is a read-only setting that displays the name of the logged on user account for the Knowledge
Base Learning Service.

Configure

Click this button to open the Windows Services window where you can configure the startup type, the
start parameters and the log on account for the Server Scheduler Service and the Knowledge Base
Learning Service.

User Profile for Kofax Capture Administration

When you use a Kofax Capture user profile, the services need to log onto Kofax Capture using a Kofax
Capture user name and password. This group has the following options.

Username

Type the user name. For additional information regarding Kofax Capture user profiles, contact your
Kofax Capture administrator.

Password/Confirm password

Type the password.

Important Make sure that the username and password are valid or the services cannot start. The Kofax
Capture user profile data cannot be validated within this tool, but an error message is added to the
Kofax Transformation Modules - Server log file.

If the services do not start, check the Kofax Transformation Modules - Server log file for error messages.

Server and Application Settings

The following settings can be set for both Logging and the Server.
Logging
You can configure the following logging settings.
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Log file path

Defines the path where the log files for Server, Knowledge Base Learning Service, Server
Scheduler, and the User Modules are saved to disk.

Log level for Correction

Defines the level of log information recorded for the Correction module. This value can be Error,
Warning, Info, Or Debug.

The value for this option is set to 1nfo by default.

Log level for Document Review

Defines the level of log information recorded for the Document Review module. This value can be
Error, Warning, Info, Or Debug.

The value for this option is set to 1nfo by default.

Log level for Knowledge Base Learning Service

Defines the level of log information recorded for the Knowledge Base Learning Service. This value
can be Error, Warning, Info, OF Debug.

The value for this option is set to 1nfo by default.

Log level for Scheduler

Defines the level of log information recorded for the Server Scheduler. This value can be Error,
Warning, Info, Or Debug.

The value for this option is set to 1nfo by default.

Log level for Server

Defines the level of log information recorded for the Server. This value can be Error, Warning,
Info, Or Debug.

The value for this option is set to 1nfo by default.

Log level for Validation

Defines the level of log information recorded for the Validation module. This value can be Error,
Warning, Info, Or Debug.

The value for this option is set to 1nfo by default.

Log level for Verification

Defines the level of log information recorded for the Verification module. This value can be Error,
Warning, Info, Or Debug.

The value for this option is set to 1nfo by default.

Purge log entries older than (days)

Deletes log entries older than the specified number of days. This ensures that the log files are not
too large and the storage space allocation does not need to keep growing.

The value for this option is set to 30 by default.

Server
You can configure the following Server settings.
Automatically start batch processing

If this option is set to ves, the Server Scheduler Service automatically polls for batches and starts
batch processing each time the Server Scheduler Service is started.
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The value for this option is set to No by default.

Important This option is enabled automatically when you install Kofax Transformation Modules
in Quiet Mode.

Batch processing polls queue for instance

Defines which instances of Server poll the queue for batches. Each instance of Server is assigned
an instance ID of either 1 or 2, so depending on which instances you are using, enter the
appropriate value or values.

The value for this option is setto 1 + 2 by default.

Extraction process restart counter

Defines how many documents are processed before the extraction process is restarted
automatically.

The value for this option is set to 1000 by default.

Extraction process retry on error counter

Defines the number of attempts that are made to restart the extraction process after it fails with an
abnormal termination. For example, OCR errors or network problems.

The value for this option is set to 2 by default.

Extraction process timeout

Defines how many minutes the extraction process is given to successfully perform an operation.
The value for this option is set to 1440 by default.

Language

Defines the language for all messages generated by the Server. For example, field validation
rules.

The value for this option is set to the set Operating System language by default.

Lifetime performance counter
Defines the length of time, in minutes, for how long the performance counters are calculated.
The value for this option is set to 30 by default.

Mailroom process restart counter
Defines how many batches are processed before the mailroom process is restarted automatically.
The value for this option is set to 1000 by default.

Mailroom process retry on error counter

Defines the number of attempts made to restart the mailroom process after it fails with an
abnormal termination. For example, network problems.

The value for this option is set to 2 by default.

Maximum batches used
Defines the maximum number of simultaneously-running mailroom processes that are allowed.

A value of 0 indicates that the maximum number of mailroom processes depend on the maximum
number of CPUs available.

The value for this option is set to 0 by default.
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Maximum memory used

You can restrict the system memory that is used by the Server Scheduler Service and any
automatically-started extraction or recognition processes by adjusting this value. The default
value is eighty percent of the physical memory; the minimum value is 200 MB. You can select a
higher value than the actual value for the physical memory, but doing so can slow overall system
performance due to extensive paging.

Note If the server hardware runs an extensive number of extraction processes or other
applications and services, be careful to select a value that leaves sufficient system memory.

Minimum batches used
Defines the minimum number of mailroom processes that are used for batch processing.
The value for this option is set to 1 by default.

Number of CPUs used

Restricts the number of CPUs used by the Server Scheduler Service.

A value of "0." indicates that the maximum number of CPUs available on the system are used.
The number of CPUs available on the system is also displayed.

The value for this option is set to 0 by default.

Scheduler communication port

Defines the port number for the Server Scheduler Service. Modify this value if the default port
number is blocked by other programs or services.

The value for this option is set to 5000 by default.

New: Server Log File

Log file records information about Server while it is in production. There are different levels of information,
depending on how the log file is configured. Each log file is a text file, with tab-separated data so it can be
opened in a spreadsheet application such as Microsoft Excel.

The name of a log file includes the name of the module, and the date. For example,
KTM Server 2017 07 31.txt.

Note The Server instance is not included in the log file. If you are using both Server1 and Server2. , you
can refer to the proc1D to distinguish between instances.

The location of the log files is configured in the Service Configuration window.

New: Log File Contents
The tab-separated columns of information in each log file are static, and therefore, not configurable.

However, the information contained in these log files is very comprehensive, so you are able to easily
navigate the files, and troubleshoot any issues.
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The location of the log files is configurable in the Service Configuration window. Each log file contains the
following columns.

* Time.

The time and date of processing. Since processing can span across a single day, this date may be
different to the date in the log file name.

* Level.

The configured level of detail included in the log. Depending on how your log files are configured, this
can be any of the following values.

» "Error." Records error events that may allow the application to continue running.
* "Warning." Records potentially harmful situations.

» "Info." Records informational messages that highlight the progress of the application at a detailed
level.

» "Debug." Records fine-grained informational events that are used to troubleshoot and debug the
application.

* ProclId.
The process ID of the application.
* Memory (KB).
The amount of memory used by the ProcessId.
* Message (Class.Method).
The Message is information about the log entry. If there is an error, it is logged here.
The class and Method indicate the origin of a particular log entry.

All three of these help identify what is causing a problem, and at what point during processing the issue
occurs.

Each log file is retained for a period of days that are configured by the "Purge log entries older than
(days)" option in the Service Configuration window.

New: Knowledge Base Learning Server Log File

The log file records information about Knowledge Base Learning Server while it is in production. There are
different levels of information, depending on how the log file is configured. Each log file is a text file, with
tab-separated data so that you can open it in a spreadsheet application such as Microsoft Excel.

The name of a log file includes the name of the module, and the date. For example,
KTM KBLS 2017 07 31.txt.

The location of the log files is configured in the Kofax - Service Configuration. The contents of the log file
are identical to the contents displayed in the Server log.

Help Updates for Document Review

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
* Updated indicates that additions, deletions, and edits exist that did not appear in previous versions
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Updated: Document Review Menu Bar - Page Menu
The following Page Menu options will be added to the Document Review help in the next full version.
Rotate 180°

Rotates the selected page by 180°.

Rotate All Pages of Document to the Left
Rotates all pages of a document 90° to the left.

Rotate All Pages of a Document to the Right
Rotates all pages of a document 90° to the right.

Rotate All Pages of Document 180°
Rotates all pages of a document by 180°.

Rotate All Pages of Batch to the Left
Rotates all pages of a batch 90° to the left.

Rotate All Pages of Batch to the Right
Rotates all pages of a batch 90° to the right.

Rotate All Pages of Batch 180°
Rotates all pages of a batch by 180°.

Updated: Document Review Menu Bar - Edit Menu
The following Edit Menu option will be added to the Document Review help in the next full version.

Copy Page to New Document
Duplicates the selected page and pastes it into a newly created document after the current document.

Help Updates for Thin Client Server

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
+ Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

Updated: Thin Client Validation Keyboard Shortcuts

The following new keyboard shortcuts are available in the Batch Content pane in Thin Client Validation.

Option Keyboard Shortcut Description

Delete Document/Delete Shift + X Removes the selected document or folder.
Folder
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Option Keyboard Shortcut Description

Split Folder Shift+ T Splits the selected folder and moves all documents
including the selected document into a new folder.

Merge with Previous Q Merges the selected document or folder to the previous

Document/Merge with document or folder.

Previous Folder

Create Folder Shift+ C Creates a folder and moves the selected documents into

that folder.

In addition, the Thumbnail pane now supports the foll

owing keyboard shortcuts.

Option Keyboard Shortcut Description
Delete Page Shift +Y Removes the selected document or folder.
Split Document Shift + S Splits the selected folder and moves all documents

including the selected document into a new folder.

Help Updates for Scripting Help

The following changes will be made to this document

ation in the next full release of this product.

* New indicates a brand new topic that has not appeared in previous versions.
+ Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

Updated: Scripting Logic

This topic has been updated as follows.

The project structure is reflected in the scripting hierarchy.

In the following overview a project structure is shown

and its reflection in the script sheets. The foldering

related script sheets are only available if folders are enabled:

+ au Project Class «» '

v & BaseClass €3
— ;L SubClass «»
4l SubSubClass «»
« ¥ Project Folder «»
- i FolderLevell «»
i FolderLevel2 «»

Project Script

Class script: Basellass
Class script: Subllass
Class script: SubSubllass
Rccthlder-script:
FolderLewell

FolderLewel2

Project Folder
Only available if Folders

Folder script: are enabled

Folder scriot:

The classification events are found on the Project Class script sheet.
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The extraction events are available on each level of the classes and most of them support inheritance.
The class-related events that are attached to the Document object from the Object combobox, are
executed from the Project Class down to the calling class. The field events are executed from the class
where the field is defined, down to the calling class. The calling class is the classification result of the
document.

Refer to the extraction events in a class hierarchy that explains the chronological events for a sample
project structure. The script events folder logic is different than it is for classes, similar to the extraction
events in a folder hierarchy.

Generally, all events that are mentioned in this documentation can be added easily by selecting the
required object from the Object combobox and the required event method from the Proc combobox in
the script sheet the object is available. The following links provide an overview where which objects are
available. You have to navigate to the script sheet where the object is declared that provides the needed
event method. If the object is placed on the project script you can directly open the requested script

via shortcut menu from the project node. If it is placed on a class script use the shortcut menu of the
requested class. The same mechanism works for the folders.

» Project Script

» Class Script
RootFolder Script
» Folder Script

Updated: Extraction Events in Class Hierarchy
This topic has been updated as follows.

When a document is classified it is assigned to a specific class, this class has a certain position in the
class hierarchy. This is important because not only the class-specific events are executed but also the
events of all its parent classes and all events on project level. This allows you to place your script to the
most appropriate class (and not repeat it for each class).

If, for instance, you have a project with a class hierarchy as shown below:

+ gu Project Class «»
- ;: Basellass &»
- ."‘. SubClass «»
{Eﬂuhﬁubﬂhﬁ e

For the Project Class, one field is defined (ProjectClassField), for the BaseClass, another field
(BaseClassField) is defined that is inherited by the child classes. subsubClassField is defined on the
SubSubClass level. A script locator method is defined on the project class (ProjectClassScriptLocator)
and assigned to ProjectClassField. A script locator method is defined for BaseClassFieldin
BaseClass (BaseClassScriptLocator).
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When a document belonging to the subsubclass class is extracted, these events occur in the following
order:

"o ddd#H##HE Project ######

ProjectClass - Document BeforeExtract *

ProjectClass - Document BeforeLocate (ProjectClassScriptLocator)
ProjectClass - ProjectClassScriptLocator LocateAlternatives
ProjectClass - Document AfterLocate (ProjectClassScriptLocator)

ProjectClass - ProjectClassField BeforeExtract *
ProjectClass - ProjectClassField AfterFieldReread * ***
ProjectClass - ProjectClassField AfterExtract *
ProjectClass - Document AfterExtract *

' #4444 ###F Classification Events #######

' ######## Document BeforeExtract #######
ProjectClass - Document BeforeExtract *
BaseClass - Document BeforeExtract *
SubClass - Document BeforeExtract *
SubSubClass - Document BeforeExtract *
SubSubClass - Document BeforelLocate (BaseClassScriptLocator)
SubClass - Document BeforelLocate (BaseClassScriptLocator)
BaseClass - Document BeforeLocate (BaseClassScriptLocator)
BaseClass - BaseClassScriptLocator LocateAlternatives
BaseClass - Document AfterLocate (BaseClassScriptLocator)
SubClass - Document AfterLocate (BaseClassScriptLocator)
SubSubClass - Document AfterLocate (BaseClassScriptLocator)

' ####44# ProjectClassField #####4#4#:
ProjectClass - ProjectClassField BeforeExtract *
BaseClass - ProjectClassField BeforeExtract *
SubClass - ProjectClassField BeforeExtract *
SubSubClass - ProjectClassField BeforeExtract *

ProjectClass - ProjectClassField AfterFieldReread * ***

ProjectClass - ProjectClassField AfterExtract *
BaseClass - ProjectClassField AfterExtract *
SubClass - ProjectClassField AfterExtract *
SubSubClass - ProjectClassField AfterExtract *

' ####### BaseClassField #######:
BaseClass - BaseClassField BeforeExtract *
SubClass - BaseClassField BeforeExtract *
SubSubClass - BaseClassField BeforeExtract *

BaseClass - BaseClassField AfterFieldReread * ***

BaseClass - BaseClassField AfterExtract *
SubClass - BaseClassField AfterExtract *
SubSubClass - BaseClassField AfterExtract

! ####4#4 SubSubClassField ######4#:
SubSubClass - SubSubClassField BeforeExtract *
SubSubClass - SubSubClassField AfterFieldReread * *x*
SubSubClass - SubSubClassField AfterExtract *

' ######44 Document AfterExtract #######
ProjectClass - Document AfterExtract *
BaseClass - Document AfterExtract *
SubClass - Document AfterExtract *
SubSubClass - Document AfterExtract *

' ####4444 Document Validated #######
ProjectClass - Document Validated * **
BaseClass - Document Validated * **
SubClass - Document Validated * **
SubSubClass - Document Validated * **



Kofax Transformation Modules Release Notes

' #######4 Document AfterProcess #######
ProjectClass - Document AfterProcess *
BaseClass - Document AfterProcess *
SubClass - Document AfterProcess *
SubSubClass - Document AfterProcess *

* Field property changes can be monitored in these events, monitoring can be turned on in the project
settings.

** The validated events are only fired when the document is valid.

*** To get the reread events of a table cell or a field, you have to activate the reread option of a field or
table column. This can be done from within the Field Properties window.

Updated: Extraction Results in Folder Hierarchy
This topic has been updated as follows.

The following example shows the sequence of extraction events that are fired when you have a project
with the folder hierarchy shown below:

= ¥ Project Folder «#
- ¥ FolderLevell s
@ FolderLevel2 &

For each level two fields are defined as shown in the following:

Root [batch level, level = 0]
-> Root Fieldl
-> Root_ Field2

Levell [level = 1]
-> Levell Fieldl
-> Levell Field2

Level2 [level = 2]
-> Level2 Fieldl
-> Level2 Field2

A batch is processed having two subfolders, that each have one sub folder, each of them contains one
document:
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|« & Batch
» = FolderLevell

« 4 FolderLevel2
» |I| 1.xdc
+ = FolderLevell
» (=3 FolderLevel2

» m Sxdc

The events then occur in the following order:

FolderLevel2 - containing 1.xdc
[folder script of folder "FolderLevel2"]

Folder BeforeExtract

Level2Fieldl BeforeExtract
Level2Fieldl AfterExtract
Level2Field2 BeforeExtract
Level2Field2 AfterExtract

Folder AfterExtract

Folder Validated*

FolderLevell - containing folder FolderLevel2 with 1.xdc
[folder script of folder "FolderLevell"]
Folder BeforeExtract
LevellFieldl BeforeExtract
LevellFieldl AfterExtract
LevellField2 BeforeExtract
LevellField2 AfterExtract
Folder AfterExtract
Folder Validated*

FolderLevel2 - containing 5.xdc
[folder script of folder "FolderLevel2"]

Folder BeforeExtract

Level2Fieldl BeforeExtract
Level2Fieldl AfterExtract
Level2Field2 BeforeExtract
Level2Field2 AfterExtract

Folder AfterExtract

Folder Validated*

FolderLevell - containing folder FolderLevel2 with 5.xdc
[folder script of folder "FolderLevell"]

Folder BeforeExtract

LevellFieldl BeforeExtract

LevellFieldl AfterExtract

LevellField2 BeforeExtract

LevellField2 AfterExtract

Folder AfterExtract

Folder Validated*

Batch
[folder script of folder "Project Folder"]

Folder BeforeExtract
RootFieldl BeforeExtract
RootFieldl AfterExtract
RootField2 BeforeExtract
RootField2 AfterExtract
Folder AfterExtract
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Folder Validated*

* The Validated event occurs only if the folder becomes valid after the extraction process.

New: Reclassify Documents via Script
The following topic will be part of the Scripting Help in the next full release.

You can change the classification result of a document in script by calling the reclassify method. This
immediately stops the extraction of the previous class and then executes extraction for the new class.

You can also use this for unclassified documents that require classification from the Project Class, by
extraction results like a bar code or form ID to a specific class. This is possible because the Project Class
script events are executed before the classification events.

Even though the reclassify method can be executed multiple times for a document, you can call it only
once per class that is executing the extraction. This is because extraction stops for a class when the
Reclassify method is called.

For example, a document is classified to a child class. You can reclassify it to the parent class, and as
soon as the extraction runs for the parent class, you can reclassify the document to yet another class.

The following extraction-related events are supported by the rReclassify method.
* Document BeforeExtract

* <Field> BeforeExtract

* <Field> AfterFieldReread

* <Field> AfterCellReread

* <Field> AfterExtract

¢ Document AfterExtract

* Document Validated

¢ Document AfterProcess

When the rReclassify method is called for a document, the field results are cleared and re-initialized
for the new class. If you want to keep the field results from the first extraction run, you can set the
preserve property of a field to TRUE. If the field is available in the new class, the field results are kept
and the extraction is skipped for this field in the new class. Only formatting and validation are applied, if
configured.

Fields, locators and project level validation rules are available in all classes as inherited items.

New: Improve Bar Code Recognition

The FineReader MinRatioToTextHeightBarcode property defines the minimum height for a bar code in
relation to the average letter height on a document. Defining this property is helpful when detecting small
bar codes.

The default value for this setting is 0.5, but if this is not sufficient, you can modify this value.

The MinRatioToTextHeightBarcode property is exposed in CscBarcodeLocator and the range for this
property is between 0.1 and 2.0.
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If the value set in script is outside of this range, the value is limited. Values below 0.1 are changed to
0.1 and values above 2.0 are lowered to 2.0. If the value is set to -1, this means that FineReader uses
automatic mode to detect bar codes.

In order to configure this property, add an additional reference for the Bar Code Locator to the script sheet
you are using. You can set this property in the Before Extract event as shown in the following example.

' Class script: MyClassName

Private Sub Document BeforeExtract (ByVal pXDoc As CASCADELib.CscXDocument)
Dim oClass As CscClass
Dim oLocDef As CscLocatorDef
Dim oBarcodeLocator As CscBarcodeLocator

Set oClass = Project.ClassByName ("MyClassName")
Set oLocDef = oClass.Locators.ItemByName ("MyBarcodeLocator")
Set oBarcodeLocator = oLocDef.LocatorMethod

oBarcodeLocator.MinRatioToTextHeightBarcode = 0.1
End Sub

Updates for Thin Client Server Installation Guide

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
» Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

Updated: Configure Thin Client Server
The following option is now available in the web.config file.

ForceDictionaryUpdate

When enabled, this setting reloads the project when a dictionary is updated so that any combo boxes are
updated accordingly. The value for this option is set to "False" by default.

Set this value to "True" in the following circumstances.

* You dictionary is configured for auto-update.

* Your dictionary is updated regularly.

* You have combo boxes that use your dictionary on your customized validation form.

Otherwise, leave this value "False." This is because a "True" value can negatively impact performance
when dictionaries are reloaded unnecessarily.

If you want to use this option in Kofax Transformation Modules 6.1.1, add the following code to the Thin
Client Server web.config file and edit it as needed.

In the Kofax.KTS.Services.Properties.Settings> section under <applicationSettings>, add the
following.

<setting name="ForceDictionaryUpdate" serializeAs="String">
<value>True</value>
</setting>
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Updated: Log Thin Client Web Server Errors

In order to troubleshoot errors with the web server that occur when using the Thin Client Server, you can
enable trace logging by editing the web . config file that is located in the installation directory.

You can enable web server trace logging in the Thin Client Server by following these steps:
1. Open the web.config configuration file and remove the comments around the following code:

<system.diagnostics>
<trace autoflush="true">
<listeners>
<add name="myListener" traceOutputOptions="DateTime"
type="System.Diagnostics.TextWriterTracelListener"
initializeData="PATH TO FILE WITH ACESS RIGHTS">
<filter type="System.Diagnostics.EventTypeFilter" initializeData="Verbose"/>
</add>
</listeners>
</trace>
</system.diagnostics>

2. Editthe initalizeData="PATH TO FILE WITH ACESS RIGHTs" attribute to modify the file system
location and name of the log file.

Important The logging folder security settings need to be modified so that the configured IIS user
(IIS_USR by default) has full control over the folder. Without this change, no log files are written
because the IIS user does not have permissions to write to that folder.

3. By default, the initializeData value is set to "Verbose." You can change this attribute to one of the
following values, keeping in mind that some options are a combination of the previous values.

Critical
Outputs a fatal error or an application crash to the log file.

Error
Outputs Critical messages as well as any recoverable errors, to the log file.

Warning
Outputs Critical messages, Error messages, as well as any noncritical problems, to the log file.

Information

Outputs Critical messages, Error messages, Warning messages, as well as informational messages,
to the log file.

Verbose

Outputs Critical messages, Error messages, Warning messages, Information messages, as well as
debug information, to the log file.

For more information about the available options, see the Microsoft MSDN Trace and Debug Settings
Schema at http://msdn.microsoft.com/en-us/library/76dt1k3h(VS.71).aspx.

4. Save your changes and restart the IIS Server.
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New: Log Thin Client Process and Batch Errors

In order to troubleshoot process errors that occur when processing batches with the Thin Client Server,
you can enable trace logging by editing the KCThinClientModule.exe.config file. This file is located in
the bin folder of the Kofax Capture installation location.

Once trace logging is enabled in the kcThinClientModule.exe.config file, additional batch-level logging
is enabled automatically. These batch-level log files are stored in a different location than the trace log
path in the configuration file. Instead, the batch-level logs are stored the same location as your image
files. For example, C:\ProgramData\Kofax\Capture\Images\0000030D\Log

For batch-level logging, the Thin Client Server creates a log file and writes entries when a batch is opened
and processed by one of the Thin Client modules. Each batch processed by an individual Thin Client
module has its own log file. The logs are named using the following format.

<Module> <BatchID>.txt
Where the Thin Client modules are called KTsSVAL, KTSVER, and KTSCOR.

If there are multiple steps of Thin Client Validation, the step number is included in the log file name. For
example, KTSVAL#1 00000005. txt.

Note If you want batch-level logging, it is necessary to enable trace logging.

You can configure the Thin Client Server to log process and batch errors by following these steps:

1. Open the KCThinClientModule.exe.config configuration file and remove the comments around
the following code:

<system.diagnostics>
<trace autoflush="true">
<listeners>
<add name="myListener" traceOutputOptions="DateTime"
type="System.Diagnostics.TextWriterTracelListener"
initializeData="PATH TO FILE WITH ACESS RIGHTS">
<filter type="System.Diagnostics.EventTypeFilter" initializeData="Verbose"/>
</add>
</listeners>
</trace>
</system.diagnostics>

2. Editthe initalizeData="PATH TO FILE WITH ACESS RIGHTs" attribute to modify the file system
location and name of the trace log file.

Important The logging folder security settings need to be modified so that the configured IIS user
(IIS_USR by default) has full control over the folder. Without this change, no log files are written
because the IIS user does not have permissions to write to that folder.

3. By default, the initializeData value is set to "Verbose." You can change this attribute to one of the
following values, keeping in mind that some options are a combination of the previous values.

Critical
Outputs a fatal error or an application crash to the log file.
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Error
Outputs Critical messages as well as any recoverable errors, to the log file.

Warning
Outputs Critical messages, Error messages, as well as any noncritical problems, to the log file.

Information

Outputs Critical messages, Error messages, Warning messages, as well as informational messages,
to the log file.

Verbose

Outputs Critical messages, Error messages, Warning messages, Information messages, as well as
debug information, to the log file.

For more information about the available options, see the Microsoft MSDN Trace and Debug Settings
Schema at http://msdn.microsoft.com/en-us/library/76dt1k3h(VS.71).aspx.

Note The initializeData value is for the trace logging level only. The amount of detail provided
in the batch-level logs is the same as the level specified in the corresponding application log in the
Service Configuration Tool.

For more information about the Service Configuration Tool and its options, see the Help for
Server, Knowledge Base Learning Server, and Services.

4. Save your changes and restart the IIS Server.

Updates for the Kofax Search and Matching Server Getting
Started Guide

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
» Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

New: Access Rights for a Microsoft SQL Server Database

Several permissions in the Microsoft SQL Server database are required by Kofax Search and Matching
Server in order to use it for the fuzzy database source. These permissions are necessary in order to
access tables, views, synonyms, and stored procedures.

At a minimum, the Server login requires the following permissions.

CONNECT SQL
VIEW ANY DATABASE
VIEW ANY DEFINITION

This permission is required by the sp databases stored procedure that is used to list the databases
that are accessible to the logged on user.

The following permissions are also required by the "database role" or "user" for each relational object.

SELECT
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This is required to access views, tables, and synonyms based on a view or table.
* EXECUTE
This is required for the stored procedure and synonyms based on a stored procedure.

* In the case of a synonym, the user or database role also requires the corresponding SELECT/EXECUTE
permissions for the underlying object referenced by the synonym.

Updates for the Kofax Search and Matching Server Installation
Guide

The following changes will be made to this documentation in the next full release of this product.
* New indicates a brand new topic that has not appeared in previous versions.
» Updated indicates that additions, deletions, and edits exist that did not appear in previous versions

Updated: Installation

The following note has been added to the Kofax Search and Matching Server Installation Guide and will
appear in the next full release of Kofax Search and Matching Server.

Important Do not install Kofax Search and Matching Server on a server alongside any other Kofax
products that are in production. This is because Kofax Search and Matching Server consumes all CPU
cores during its search queries, to maximize performance.

For example, Kofax Search and Matching Server and Kofax Transformation Modules are both
installed on the same server. When Kofax Transformation Modules is busy with OCR for a large set of

documents, a search by Kofax Search and Matching Server is unable to access enough the CPU power.

This results in a slow-down in the overall processing time because the two products are competing for
processing power.
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